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Frontispiece. Examples of basement rocks cored at Site 1277 in the Newfoundland Basin. A. A mass-flow deposit
consisting of subangular to rounded clasts of serpentinized peridotite (with spinel foliation) and rare gabbros in a clay-rich
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calcareous matrix (interval 210-1277A-4R-1, 47.5–62.5 cm; 123.5 mbsf). B. An altered gabbro containing plagioclase and
pyroxene porphyroblasts in a strongly altered, weakly foliated, chlorite-rich matrix (interval 210-1277A-2R-1, 96–107 cm;
104.9 mbsf) lies ~19 meters above A. The gabbro is interpreted to be a sliver of crust displaced by mass movement at the
contemporary seafloor. Only serpentinized peridotites were recovered in the lower part of the hole, and these are
interpreted to represent in situ basement that was unaffected by mass wasting. C. A homogeneous, foliated,
porphyroclastic serpentinized peridotite dissected by a polyphase network of calcite and talc veins (interval 210-1277A-7R-
2, 107–122 cm; 154.3 mbsf). D. A massive, foliated, serpentinized peridotite (harzburgite). The strong foliation is
interpreted to be mylonitic (crystal-plastic recrystallization of olivine with porphyroblasts of pyroxene) (interval 210-1277A-
9R-4, 30–45 cm; 175.3 mbsf).
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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
Shipboard Scientific Party, 2004. Leg 210 summary. In Tucholke, B.E., Sibuet, J.-C., Klaus, A., et al., 
Proc. ODP, Init. Repts., 210: College Station TX (Ocean Drilling Program), 1–78.

CD-ROM volume citation:
Tucholke, B.E., Sibuet, J.-C., Klaus, A., et al., 2004. Proc. ODP, Init. Repts., 210 [CD-ROM]. Available 

from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2004. Site 1276. In Tucholke, B.E., Sibuet, J.-C., Klaus, A., et al., Proc. ODP, 
Init. Repts., 210, 1–358 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, 
College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: October 2004

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 207 (Initial Reports): March 2004
Volume 208 (Initial Reports): May 2004
Volume 209 (Initial Reports): June 2004
Volume 188 (Scientific Results): August 2004
Volume 189 (Scientific Results): October 2004
Volume 192 (Scientific Results): October 2004
Copies of this publication may be obtained from Publications Distribution Center, Integrated Ocean 
Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. 
See the ODP publication list at www-odp.tamu.edu/publications or contact IODP for prices and 
ordering information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions 
will be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 

The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the Data Librarian, Integrated Ocean Drilling Program, Texas A&M University, College 
Station TX 77845-9547, USA. E-mail: database@iodp.tamu.edu.

Some close-up core photographs have been tonally enhanced to better illustrate particular features of 
interest.

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 

ODP publication standards.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph of the JOIDES Resolution at sea on her final Ocean Drilling Program leg by ODP 
Photographer John Beck.

http://www-odp.tamu.edu/database
mailto:database@iodp.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, the fluctuations of climate, and the study of the 
Earth’s deep biosphere.

Although ODP ended operations in 2003, science results from ODP’s expeditions on the JOIDES Resolution 
continue to emerge. The results represent the contributions of scientists and research institutions from 22 ODP 
member countries. International oversight and coordination of the program was provided by the ODP Council, 
which was made up of representatives from the member countries. Scientific and management guidance was 
provided by representatives from the Joint Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 20 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implemented scientific objectives, plans, 
and recommendations of the JOIDES committees through subcontracts to Texas A&M University (TAMU) for 

science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO worked together successfully for many years to manage the Ocean Drilling Program. We 
look forward to many exciting discoveries and continued international collaboration on the Integrated Ocean 
Drilling Program as we further our scientific mission.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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http://www.nsf.gov/


10
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Joint Oceanographic Institutions, Inc.
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E-mail: info@joiscience.org
Web site: www.joiscience.org
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Integrated Ocean Drilling Program

ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory 
of Columbia University

PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
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ODP SITE SURVEY DATA BANK

Texas A&M University
1000 Discovery Drive
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Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: information@iodp.tamu.edu
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Lamont-Doherty Earth Observatory 
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Web site: ssdb.ldeo.columbia.edu

mailto:info@joiscience.org
http://www.joiscience.org
mailto:information@iodp.tamu.edu
http://iodp.tamu.edu/
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http://www.ldeo.columbia.edu/BRG/ODP
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segregation logs; and digital images are included in this section. VCDs; smear slide and thin section 
data tables; piece, vein, and magmatic segregation logs are combined into one PDF file for each site. 
ASCII versions of smear slide data tables are also available (see “ASCII Tables”).
Site 1276

Visual Core Descriptions · Smear Slides · Thin Sections · Piece Log · Vein Log · 
Magmatic Segregation Log

Site 1277

Visual Core Descriptions · Piece Log
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of paleomagnetic data tables from the “Site 1277” chapter and 
all of the smear slide data tables presented under “Core Descriptions.” A complete listing of the 
ASCII tables can be found below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.
Chapter 4, Site 1277
Table T2. Remanent magnetization intensity and inclination, Hole 1277A.
Table T3. Magnetic susceptibility measured with the point-susceptibility meter (AMST), Hole 1277A.

Smear Slide Data Tables
Hole 1276A smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary material data files presented as PDF and Excel 
97/98 spreadsheets. The files present a common midpoint navigation map and an expanded coring 
summary table. Supplementary material files are located in the SUPP_MAT directory.

CMP_NAV
CMP_NAV.PDF

CORE_SUM
1276_SUM.XLS

README.TXT
CD-ROM CONTENTS: DRILLING LOCATION MAPS
Two site maps showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF.

ODP Leg 210 Site Map 

ODP Map (Legs 100–210)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A CD-ROM containing processed logging data and a subset of core data is included with the printed 
version of this volume. However, a more complete set of the logging data collected by ODP Logging 
Services is available online at www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html. If 
you have problems downloading the data, wish to receive additional logging data, or have questions 
regarding the data, please contact: Data Services Manager, ODP Logging Services, Borehole Research 
Group, Lamont-Doherty Earth Observatory of Columbia University, PO Box 1000, 61 Route 9W, 
Palisades NY 10964, USA; Tel: (845) 365-8343; Fax: (845) 365-3182; E-mail: 
logdb@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: Data Librarian, 
Integrated Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 
77845-9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@iodp.tamu.edu.
COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–178, 180–183, 186, 188, 189, and 192. The 
indexes are contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg 
number). These indexes can be searched individually or collectively. For information on using the 
Acrobat search function, see “Searching a PDF Document” in README.PDF.

http://www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html
mailto:logdb@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@iodp.tamu.edu
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

210IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR210_01.PDF (Leg 210 Summary)VOLUME
(Leg 210 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 210)

CHAPTERS
(Volume chapters)

210_MAP.PDF
(Leg 210 site map)

IR210_02.PDF (Explanatory Notes)

IR210_03.PDF (Site 1276)

IR210_04.PDF (Site 1277)

IR210_05.PDF (Data Report: Marine
Geophysical Data)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(ASCII tables of paleomagnetic and
smear slide data)

IR210_04 (Chapter 4 files)

S_SLIDES (Site 1276)

README.TXT

OVERSIZE
(Large-format tables and figures)

IR210_03 (Chapter 3 files)

IR210_05 (Chapter 5 files)

MOVIES
(QuickTime viewable movies)

IR210_03 (Chapter 3 files)

COR_1276.PDF (Site 1276)CORES
(Visual core descriptions; smear slide
and thin section data tables; piece,
vein, and magmatic segregation logs;
and digital core images)

COR_1277.PDF (Site 1277)

IMAGES (PDF files of core images)

README.TXT

MAC

UNIX

WINDOWS

SUPP_MAT
(Supplementary Material)

CMP_NAV
(CMP navigation map in PDF)

CMP_NAV.PDF

CORE_SUM
(Hole 1276A expanded coring
summary table in Excel)

1276_SUM.XLS

README.TXT

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
210 Initial Reports)

(Continued on next page)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

MAC

WINDOWS

README.TXT

QUIKTIME
(QuickTime 6.5.1 installation
software and instructions for
different platforms)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 178NDX.PDF, 
180NDX.PDF through 183NDX.PDF, 
186NDX.PDF, 188NDX.PDF, 189NDX.PDF
and 192NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)
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